From the Chief Editor's Desk

Papawoob

Welcome everyone to the eighteenth issue of PCLinuxOS Magazine. With the arrival of the new year we also brought you a new theme for our pdf readers. I would love to hear what you think of it. Please visit the forum at www.pclosmag.com or drop me a line at: papawoob@pclosmag.com and let us know what you think.

This month we are bringing you more interesting articles that will allow you to recover from a lost root password or setup a dualhead monitor using an Nvidia graphics card. You will also find out how to setup Joomla with it’s own server to give you the basics to begin learning how to use Joomla to build your own website. Ever wanted to learn how to code? This month's article on RealBasic will get you started.

Next month will have an updated article on installing and setting up Dansguardian on your child's computer to give you some peace of mind while your child ventures out on the web. We also need your input on articles that you would like to see or, send us one on the usefulness and configuration of your favorite application. You can also send us stories of how you came to Linux and the journey to your decision to use PCLinuxOS. We would also like to see some opinion articles on computer related subjects that you feel strongly about.

Enough ramblings from an old geek. Page down and read away!

Papawoob
Testimonials

PCLOS is unbelievable!!! I bought an IBM ThinkPad390E off Craigslist for $75, added a $35.00 Belkin card, and installed it tonight after reading over all the forums for two days on this issue. No sooner had I done a total update from Synaptic, a 3-4 hour process with download & install time, than the NDISWRAPPER successfully used the windows .inf file off the Belkin CD, set up the link, and I've got an incredible wireless laptop for about $100!!!

PCLOS has achieved remarkable user friendliness in the last few years, far ahead of the other distros in my opinion, mainly because of its Internet functionality with flash, java, real player, & mplayer. I've found no other distro that installs & works flawlessly for all those programs. Tex & the other developers deserve all the accolades that PCLOS has been getting in the press & community, now and in the future.

earth
Letters to the Editor

Papawoob

Just wanted to tell my experience with PCLinuxOS. I found it the best home desktop on top of kde, even my 10 year old nephew does some computing on it without any hassles. Computing was never this easy.

Now we both are waiting for the next pclos release. If Linux is a good option to computing, then pclos is a good option to Linux.
Keep up the job!!

Love and regards,

Manmath

Welcome to the community! There are many here who share your opinion. Keep spreading the word.

Papawoob

Just wanted to tell you that I think you have one of the easiest to install and easiest to use Linux distros out there. I have an older Dell Latitude Cpi laptop I wanted to put Linux on. Tried several other distros, could not get any of them to work quite right. Popped in the PCLinuxOS cd, and everything worked as it was supposed to. Apparently your distro is better suited to laptops than some of the other ones.

Jim Fortune

With the great variety of PCLOS derivatives there should be something that works on just about anything.
Welcome!

Papawoob
Just wanted to say thanks for a great distro. You guys are a mile ahead of the pack. I recently decided to try other distros on some of the family computers (we have 4 not counting my laptop) and they're all back to PCLinuxOS. Some were a nightmare, others just disappointing, but its alright because it just makes me appreciate PCLinux that much more. The forums and chat support are outstanding. I'd like to give a couple of examples, I had a minor config issue and quickly got a responce from Texstar himself. Another occasion I requested a game be added to the repo and it was added in less than 24 hours with a message from Texstar. I know the second wasn't a tech issue but I found it very impressive that as busy as you guys must be, to take the time to get something as irrelevant as a game out in such a short time just shows your commitment to your users. I can't say thanks enough.

itsgregman

*We are all spoiled here by Tex and the Gangs commitment. Glad you have found your Linux home.*

*Papawoob*

Hi there

Being new to the linux system I was having a hard time getting what I wanted, ie: making it work for me rather than the other way round. PCLOS has delivered the goods where the others could not and it has sustained my interest in linux. Thankyou.

Regards,

New convert

*Welcome to our community! I am glad you have found PCLinuxOS to be the one to keep you in the world of Linux and Open Source. PCLinuxOS has become the the "distro hopper stopper" for many of us.*
Configure Mozplugger to Play MIDI Files

Mozplugger is installed by default in PCLinuxOS. Amongst its many capabilities is to play midi files embedded in an html page if Timidity (a software synthesizer) is installed.

First you will need to install Timidity from the repositories using Synaptic. Open Synaptic using either the icon in your panel or from the start menu.

Start -> System -> Configuration -> Packaging -> Synaptic Package Manager

Click on the Search button, type in Timidity, and then click on the search button. In the window that pops up you will see 4 apps. Click on the box to the left of Timidity++ to mark it for installation. Click on Apply next and you will see a window that tells you that Synaptic also needs Timidity-patch-free. Click Apply, and the download and installation will proceed. When it is finished, close Synaptic.

However, in my experience, it is also necessary to change the settings by modifying the /etc/mozpluggerrc file using a text editor. If you don't do this, depending upon your system and the mozplugger version, you may get either too much reverberation, or no output at all. To do this we will need to use our file manager in Super user mode. Go to:

Start -> System -> File Tools -> File Manager – Super user mode

Enter your root password and click OK. When your file manager opens you need to navigate to /etc/mozpluggerrc. You will find 4 mozpluggerrc files, .default.rpmnew, .default.rpmsave, .rpmnew, and .rpmsave. Double click on the first file and it will open in Kwrite. Scroll down to the Audio section and on the 5th line change:

controls noisy stream: timidity -Od "$file"
controls noisy stream: timidity "$file"

Once you have done this, save the file and close Kwrite. Repeat these steps on each of the three remaining mozpluggerrc files and when you are finished close your file manager. Thats all folks!
How to Recover from a Lost Root Password

Newbies please note: this is a potentially dangerous operation that could damage your installation. Use it if you must, but understand that if the operation goes wrong, the system could be damaged. This could affect your precious data!
A factor I love about Linux is one is rarely alone: if in doubt, seek help before proceeding.

This information was gleaned from the Forum, and is for the user who has an understanding of the Linux file system.

So you have lost or forgotten your root password. Woe is me! Do not fear, your forum members have provided a couple of methods to recover from this situation. Since Linux is all about choice, use the one that suits you. Remember, there is no need to reload (reinstall) just because of a lost password.

Method 1:

Boot your machine using the LiveCD.

Once loaded, mount your original / (root) directory. (WARNING!!! Anything done as the root user can affect the usability of your system!) I usually will mount it as orig_root. Then from a terminal window:

```
cd /orig_root/etc

su using the LiveCD's root password (if you are using PCLinuxOS, this will be 'root'), then using you favorite text editor, edit the shadow file.
```
Example using nano, type:

nano shadow

this will load the shadow file and you should see something as follows. Yours may differ:

```
root:$1$8NFmV6tr$rT.INHxDBwn1VvU5gjGzi/:12209:0:99999:7:-1:-1:1074970543
bin:*:12187:0:99999:7::
daemon:*:12187:0:99999:7::
adm:*:12187:0:99999:7::
```

we want to work with this line
```
root:$1$8NFmV6tr$rT.INHxDBwn1VvU5gjGzi/:12209:0:99999:7:-1:-1:1074970543
```

In this example, this is the encrypted password
```
$1$8NFmV6tr$rT.INHxDBwn1VvU5gjGzi/
```

Remove this encrypted password. DO NOT remove the "::" before or after the encrypted password. After removing that portion of your line it should look something like below. Note: your may have different information.

```
root::12209:0:99999:7:-1:-1:1074970543
```

In nano, pressing Ctrl and x will prompt you to save the file. After saving the file, reboot your machine without the LiveCD.

Now your machine has no root password. To add your new root password to your system open a terminal window and type in "passwd root" (without the quotes) and press the enter key. You will be prompted for a new root password. When you type it in it will not be displayed. After entering it, press return. It will then prompt you to enter it again (again it will not be displayed when entering it.) After typing it in, press enter, and now you have a new root password.

Method 2:
Booting into single user mode from GRUB

When grub comes up hit escape. Click "ok" when it states you are leaving graphical mode. Highlight your boot entry, usually the first one. Press "e" to edit.
This will highlight the first line (yours may look different):

```
kernel (hd0,0)/boot/vmlinuz-2.6.22.10.tex1.lgc BOOT_IMAGE=2.6.22.10.tex1.lgc root=/dev/hda1 acpi=on resume=/dev/hda5 splash=verbose vga=794
```

Append it so it reads (by adding 'single' to the end of the line):

```
kernel (hd0,0)/boot/vmlinuz-2.6.22.10.tex1.lgc BOOT_IMAGE=2.6.22.10.tex1.lgc root=/dev/hda1 acpi=on resume=/dev/hda5 splash=verbose vga=794 single
```

Press enter. Press "b" to boot in single user mode. You should now see this:

```
sh-3.1#
```

Type `passwd` and press enter. You will be asked for the new password and to retype it. After it accepts the password it will return to the prompt. Type `reboot` and press enter. You are now back in business.

**Method 3:**

Booting into single user mode from Lilo

When the Lilo screen shows up (the one where you can select which operating system to boot) press the Esc button. This will bring up a boot prompt. Type `pclinixos 1` and press enter.

PCLinuxOS means that you want to boot pclinixos, the 1 means runlevel 1 i.e. single user mode. This will boot to a root# prompt (without asking you for the password) so you can now change it with the passwd command to
whatever you want.

Type `passwd` and press enter. You will be asked for the new password and to retype it. After it accepts the password it will return to the prompt. Type `reboot` and press enter.

Have Fun!
Setting Up autofs

This article was taken from the forum, and it was felt it would be interesting for the more experienced user. The article is one way to allow automatic filesharing of Samba shares, on 2 servers, in this example named 'Cedar' & 'Walnut'.

Thought I might contribute a howto on setting up autofs, which allows automatic mounting and unmounting of filesystems. Other howtos on the Internet were helpful but somewhat confusing for me. So here's my setup using two Linux samba servers (one Ubuntu and one PCLOS) and my local PCLOS desktop.

This assumes you have samba running on a server(s) and that you have it configured correctly. The important things from the smb.conf file concerning the shares on my "Cedar" samba server, for example, are:

[Cedar_Share]
path = /home/cedar_share
comment = Shared Directory on Cedar
browseable = yes
public = no
writable = yes
create mask = 0765
valid users = username1 username2

[Cedar_Data]
path = /mnt/data
comment = External Drive on Cedar
browseable = yes
public = no
writable = yes
create mask = 0765
valid users = username1 username2
The above assumes you want to allow the samba user to write to the shares.
On the local PCLOS machine you also need to have the files:
/etc/samba/auth.walnut.username1
/etc/samba/auth.cedar.username1

which contain the samba username and password for the user who will be automounting the samba shares (or
local partitions) with autofs.

The samba auth.host.username files can be created by the PCLOS Control Center/Mount Points/Set Samba
mount points. However, if you have it write to the etc/fstab file, be sure to comment them out or delete them from
the fstab file afterward.
Now install autofs via Synaptic (autosmb is not needed)

Below are how I have my auto.* files set up. You can configure however you like. Each file points to another
auto.file or to the share that it will mount.

The auto.master file (below) points to two files:
auto.misc and auto.hosts.
The initial mount points, /mnt/local and /mnt/hosts) need to be created, however
no other directories do. The timeout option will unmount the shares in 30 seconds, and ghost images of the
mounted directories will be kept after the mount goes away.

# Start File: /etc/autos/auto.master
/mnt/local /etc/autos/auto.misc --timeout=30 --ghost
/mnt/hosts /etc/autos/auto.hosts --timeout=30 --ghost
# End file /etc/autos/auto.master

The auto.hosts file points to two more files, one for each server (cedar and walnut). The hostname mount points
(Cedar and Walnut) will be automatically created by autofs under /mnt/hosts when autofs mounts a share.
# Start file: /etc/autos/auto.hosts
Cedar -fstype=autofs file:/etc/autos/auto.cedar
Walnut  -fstype=autofs  file:/etc/autofs/auto.walnut
# End file /etc/autofs/auto.hosts

The auto.walnut file tells autofs how and where to mount the shares from the walnut server. The mount points data and www will be automatically created by autofs under /mnt/hosts/Walnut.

# Start File: /etc/autofs/auto.walnut
data-fstype=smbfs,credentials=/etc/samba/auth.walnut.username1,uid=501 ://walnut/data2
www-fstype=smbfs,credentials=/etc/samba/auth.walnut.username1,uid=501 ://walnut/www
# End file: /etc/autofs/auto.walnut

The auto.cedar file is much like the auto.walnut file...
# Start File: /etc/autofs/auto.cedar
Data -fstype=smbfs,credentials=/etc/samba/auth.cedar.username1,uid=501 ://cedar/Cedar_Data
Share -fstype=smbfs,credentials=/etc/samba/auth.cedar.username1uid=501 ://cedar/Cedar_Share
# End File: /etc/autofs/auto.cedar

The auto.misc file will mount a local partition. The mount point "backup" will be automatically created under /mnt/local.
# Start File: /etc/autofs/auto.misc
backup   -fstype=ext2   :/dev/hdc1
# End File: /etc/autofs/auto.misc

Now start the autofs daemon as root from the command line with

/etc/init.d/autofs start

Stop or restart with:

/etc/init.d/autofs stop
/etc/init.d/autofs restart
Using Konqueror, I can now navigate into the directory shares 
I just set up. Autofs will quickly mount them.

If I go into each of the shares, do "df" at the command line, 
The mounted filesystems look like:

<table>
<thead>
<tr>
<th>Filesystem</th>
<th>Size</th>
<th>Used</th>
<th>Avail</th>
<th>Use%</th>
<th>Mounted on</th>
</tr>
</thead>
<tbody>
<tr>
<td>//cedar/Cedar_Data</td>
<td>15G</td>
<td>903M</td>
<td>14G</td>
<td>7%</td>
<td>/mnt/hosts/Cedar/Data</td>
</tr>
<tr>
<td>//cedar/Cedar_Share</td>
<td>6.4G</td>
<td>164M</td>
<td>6.2G</td>
<td>3%</td>
<td>/mnt/hosts/Cedar/Share</td>
</tr>
<tr>
<td>//walnut/data2</td>
<td>56G</td>
<td>22G</td>
<td>34G</td>
<td>39%</td>
<td>/mnt/hosts/Walnut/data</td>
</tr>
<tr>
<td>//walnut/www</td>
<td>7.4G</td>
<td>3.2G</td>
<td>4.3G</td>
<td>43%</td>
<td>/mnt/hosts/Walnut/www</td>
</tr>
<tr>
<td>/dev/hdc1</td>
<td>57G</td>
<td>5.1G</td>
<td>49G</td>
<td>10%</td>
<td>/mnt/local/backup</td>
</tr>
</tbody>
</table>

If Konqueror is closed, and there is no longer any activity in 
those directories, they will be unmounted. The mounts can also 
be activated from the command line or from any application. 
For example, for the command line...

touch /mnt/local/backup/testfile.txt

would automatically mount the partition and create testfile.txt in that directory. 
Then 30 seconds later the partition would be unmounted. 
Thats it.
nVidia Dual Head Setup

Thought I might share my recent (fortunate) success.

First off, I'm using a cheapo Nvidia 5200FX with with 2 Dell LCD's with different resolutions (1024x768 & 1280x1024)

1. Install the card and for simplicity's sake try to determine which vga (or dvi) is the primary and hookup your main monitor to it (not an issue if you have identical monitors, in my case it's the 1280x1024); then hookup the 2nd one.

2. Boot up and install the proper **DKMS-NVIDIA** module for your card via Synaptic and restart X when prompted. Below you will find the available **DKMS-NVIDIA** modules listed in Synaptic.
   - DKMS-NVIDIA_100.1
   - DKMS-NVIDIA_169.xx
   - DKMS-NVIDIA_71xx
   - DKMS-NVIDIA_96xx
   - DKMS-NVIDIA_97xx
   - DKMS-NVIDIA_cuda

3. Make sure everything is working properly on your primary monitor. At this point, backup your xorg.conf by issuing the following commands in Konsole:
   Code:
   ```
su
   cp /etc/X11/xorg.conf /etc/X11/xorg.conf.bak
   ```

4. Goto System->Configuration->Hardware->Nvidia Settings

5. Under "X Server Display Configuration" you *should* see a diagram of your monitor setup in the Layout area.
Click on the one that says (Disabled) then choose the Configure button and pick "Twinview."

6. Look over the resolution settings and such for the new display, hopefully you can leave everything as is or choose "Auto", then click "Save to X Configuration File."

7. At this point you will be prompted to logout and restart X (after logout hit ctrl-alt-backspace to be sure)

8. If you are lucky, you will now have a funky-looking desktop spanning both monitors. If you get spit out to the console, login as root and issue the following commands to restore your working single monitor xorg:

   Code:
   ```
   cp /etc/X11/xorg.conf.bak /etc/X11/xorg.conf
   ```

   (answer yes to overwrite xorg.conf).

   Then go back to Nvidia-settings and fiddle with the 2nd display settings as necessary and repeat from step 6.

After you have a successful setup, you can go into KDE's desktop settings to put the same or different wallpapers on each screen (there will be new options in Configure Desktop) and you can use Add New Panel from screen 1 to add a kicker panel to screen 2 to simulate a kicker that spans both desktops. Cool!
It's Elementary Watson...REALbasic

Gary L. Ratcliff Sr.

One of the things about computers and computing which has always been of interest to me is learning to use new computer languages. This desire to program in many languages was one of the things which prompted me to graduate from the Commodore PET of 1978 to a Commodore SuperPET in 1981. The main draw was the five languages it offered: APL, Assembler (6809), Basic, Cobol, and Pascal.

My move to Linux was prompted by learning that it offered compilers for many languages. Those who purchased computers in the late 70's and early 80 were most likely introduced to the BASIC computer language. If you wanted the machine to do anything other than blink and let you know that it was READY, you had to learn to program it to do something and that meant learning to program in BASIC.

PCLinuxOS comes with many languages available in the software repositories. And one of them is remarkable in that it is a commercial product. Unlike most which are offered under a GPL license, this is sold for software development by Real Software, located in Austin, Texas. It is actively developed and has a new release about every three months. The most recent release was REALbasic 2007 release 5 which was released in November of 2007. By the time you read this article the next release REALbasic 2008 release 1 should be available for download.

How to get REALbasic

There are two approaches which might be used to obtain REALbasic for your system: Install it from the PCLinuxOS repositories, or obtain it from REAL Software. Each of these approaches also offers some options.

From the system repositories one may use either the command line or the GUI approach to getting the software. First, let us take the command line route:

Open a terminal by clicking on the terminal icon if it is on your desktop or using the start menu and going to
"System", then going to "Terminals", then choose "Konsole" from the sub-menu which appears. Become root so that you may install the software by giving the command:

```
su
<enter root password then press Enter or return>
```

(you will notice that you are root as the text color should now be red (and the cursor changes from $ to #). This is to warn you that as root you can do some serious damage to the system if you aren't extra careful when entering commands)

Get the software and install it using the command:

```
apt-get install REALbasic
```

Now exit from the terminal program (type exit and press Enter or return) as you should be able to read that your new software has been correctly installed.

The GUI approach involves using Synaptic to install the software for you. To use this approach: From the start menu select "System", then select "Configuration", then choose "Packaging", and finally select "Synaptic Package Manager." Now you will be prompted to enter the root password and the program will launch. Select the search item and enter REALbasic as what you desire to find. Once the search is complete, select the item by clicking on the small box to the left of the item name to indicate that you wish to mark this program for installation. Once this is done, select "Apply" and soon your software will be installed.

On the basis of my explorations, installing from synaptic offers these shortcomings:

First, the release is only REALbasic 2007 release 4. Second, the documentation files which you will need to use to learn to operate the system are not loaded. (This happened on both my 128 meg Dell Dimension 8100 and HP a1253w systems.) The system will guide you toward the Real Software website to get the documentation, but this fails to work. For this reason my recommendation is to obtain the most recent release directly from Real Software.

REALbasic will compile code for either Mac, Windows, or Linux systems. Now the company offers three forms of
download of the most recent REALbasic release 5 for Linux: There are .tgz, .rpm, and .deb packages of this software and each is listed as being 39.1 megs in length. Although Ubuntu and Debian systems use apt-get and Synaptic your PCLinuxOS system uses Red Hat Packages commonly known as .rpm's. The versions of apt and Synaptic have been specifically tailored to work with rpm type packages.

To install the tgz version you will first become root following the same method outlined in the discussion of apt-get. Once the software has been downloaded from the REAL Software site, you should find it on your desktop. You will use this set of commands:

```
su
<enter root password>
cd /home/gary/Desktop (Use your username here)
tar xzvf REALbasicLinux.tgz
exit
```

The x just means to extract the file, the z uncompressed it, the v is for verbose so that the program tells you every move, and the f is for file which names the file upon which you wish to operate.

You should now find a folder on your desktop named: "REALbasic2007r5" and by clicking on this file it should open. You can get the program to launch by double clicking the REALbasic icon (the one which looks like a cog.) The system will let you know it is loading the Artwork and the Framework and you will soon be presented with the Project window.

If you opt to download the rpm package the instructions would be similar but you would use the command:

```
rpm -i REALbasicLinux.rpm
```

instead of the tar command. If you use the rpm method the package will be added to the menu structure. So to launch REALbasic (if you followed this path) you would use the Start menu and follow this with selecting "More Applications", next select "Development", then follow this with "Development Environments", finally launch the application by clicking the "REALbasic 2007r5" item which appears. This will display the same progress reports as the same program launched from the folder.
Learning how to program using REALbasic

You now have the REALbasic program running and are ready to begin programming. However, you now remember that you don't know how to program at all. The "Help" menu is where you should turn. The Real Software team has provided a complete set of manuals and guides to correct this problem. The information is provided in the ubiquitous pdf format. There are programs on the default system or you may chose to install Abode Reader (this is found in the PCLinuxOS repositories, or you may use Kpdf). Of course, if you are reading this magazine in the pdf format it would be obvious that you already know how to read this type of file.

The logical place to begin is the REAL Basic Quick Start pdf. This shows the construction of a simple application and guides you into learning the items on the menu and the tool bars and other items, which, until you learn their function, will be foreign to you. This guide suggests that the reading and learning may be completed within a single hour.

Follow this with reading the REAL Basic Tutorial pdf. This explains some of the concepts of object oriented programming and builds a more complicated application.

The most complete of the reference materials is the REAL Basic Users' Manual, also in pdf format. This is a 664 page document and it goes in a logical manner through each step. It is best read in order. However, the search facilities would enable one to refresh their memory by taking you directly to the information you need.

Then the Help Menu also enables one to reach The REAL BASIC Language Reference. Also, if you make a mistake in your programming, the REALbasic system immediately comes to your aid with suggestions to solve your problems.

A Sample Application

Almost any computer text, regardless of the language being introduced, will present a program for your very first programming experience. Searching Google for this item should show a site offering the program in over 100 different computer languages. And so, without further ado, we bring you the "Hello World!" application in
REALbasic.

With the system just opened, click on the Window. You will note that this creates a new tab. Having read the quick start guide you should recognize the properties pane and the design pane. Move your mouse to the right into the properties pane and click on the Name: Window1 and change this to wnMain. While In this same property pane, change the Title from "Untitled" to "Linux app" You will note that the text on the box in your window will change from Untitled to Linux app.

The box will be rather square. There are some little boxes present in the outline of the window. Use the mouse to hold the one on the lower right side and drag the mouse until you achieve a rectangle about 1 inch tall and 3 inches long. Next, on the items portion, locate the "pushbutton" control. Double click on this and it will appear on your 1 by 3 window with the caption untitled. With this selected, your properties pane will read pushbutton1. Here the caption will read "untitled." Click on this and then change the text to read: "Press Me"

This completes the interface. We have a window and a control. Next, the BASIC language enters the picture as we will use the language to tell the system what to do if the control is pressed. By double clicking on the control; we will open the code window and you will notice that the Action item is shaded. Place the cursor into the text entry area and give this command: "MsgBox", as MsgBox (REALbasic will complete this for you.) The completed command would be: MsgBox "Hello World!"

Now place your mouse on the RUN control on the tool bar and click. You will see a blank window and a large blue line as your program is compiled. Then a window will appear on the screen and you will see a push button on this window which says: "Press Me." You will also notice that REALbasic has added a menu bar populated with File and Edit options.

Once you press the control another window will pop up and it will say "Hello World!"

This will also have a control which says OK. Clicking this will remove the "Hello World!" window. To exit the program select the File menu and click on the Quit option. (Or pressing Ctrl Q will also exit the program.)

Having the application performing as we desired, we are ready to change it into a stand alone application. In using REALbasic you will use RUN several times to Test and once the system works as expected, Build the program.
Note that REALbasic adds the menus for us. Here The File menu gives Quit. In the Windows version this menu gives Exit.
Hello, World!

Here, just click the Build icon. (Your program will only Build for Linux. Purchasing the Professional version would allow you to construct programs for Mac, Windows, or Linux using the same design and code.)

Now the system names the program "MyApplication" To see this run as a stand alone application, issue this sequence from a terminal:

cd /home/gary/Documents (use your name)
./MyApplication

You can also click on “MyApplication” to run it as a stand alone and also you can right click on “MyApplication” and click on rename to rename “MyApplication” to “Hello.”
Ok, it works without REALbasic being loaded. The first item is to change the name which is accomplished by giving the move command as:

```
mv MyApplication Hello
```

Notice that when in a terminal window you can tell that an item is an application because it will appear in green text. So the end result is that if you list the contents of the Document folder, what once was "MyApplication" in green text now reads "Hello" in green text. Launching is now accomplished with ./Hello now.

In any serious application you will wish to incorporate your master piece into the menu structure so that it may be easily launched. On your System this is accomplished via the sequence from the start menu: "System" ... "Configuration" ..." Menu Editor." Once the Menu Editor launches, we will install the system to the menu by selecting from the File Menu: "New item." Then we will complete the form with these entries:
Name: Hello
Comment: "Hello World!"
Command: /home/gary/Documents/Hello

The other items which are checked for their default behavior may be left alone. We do not wish to run this application in a terminal so the box should be unchecked. "You will now want to update your new menu structure by selecting 'File' then 'Save.' Once the system has saved your altered menu you will find the title "Hello" at the top of the menu list. The application may now be launched by clicking on it.

We have seen how to develop an application, build it into a stand alone product, and install it into our menu system for ease in implementing it. The Build Menu has options to try to build for other systems, but this is only possible if the Professional version is purchased.

**REALbasic on the telly**

It is said that one picture is worth a thousand words. So for a real quick grasp of some of the capabilities of this system you may want to view all of the episodes of realbasic.tv. This is reached via launching Firefox and
This is the REALbasic.tv website. Each episode may be downloaded for future viewing and study.

The home page will be a list of the current episodes. These should be viewed in sequence as one builds upon what has been learned in the previous episodes. The first episode makes clear what reading the pdf files may not have explained fully. Actually seeing the application develop reveals just how easy and powerful the system is.

In episode 4, a tic-tac-toe game is started. I well remember creating just such a program about 25 years ago using the graphic character set of my Commodore PET. The ease with which the board is created and the logic used to
create the game is similar. However, this version shows just how much object oriented programming has improved the power available to the programmer.

Unfortunately, the host of the program had his production computer stolen and there was a long delay in getting from this episode to the next. The tic-tac-toe game is to be made playable over a network and the conclusion of this project is for a future episode. The show promises that since the host now has a new system, episodes will continue to appear on a more regular schedule.

There are presently five episodes. You may choose to view them online. A more useful way is to just download them to the desktop and use k3b to burn them onto cds. Episodes 1, 2 and 5 will nicely fill one 800 meg cd to capacity. Episodes 3 and 4 may be burned to another.

"The episodes may be viewed using either mplayer or KMplayer on your PCLinuxOS system. If the user made cds of the episodes and also archived the episodes to a usb hard drive such as Mybook as mentioned in my article on Multibooting they may wish to install another player recently added to the PCLinuxOS repositories. This is Miro (once called Democracy player.) Enter Synaptic and search for miro. Then mark it for installation. Now select apply to have the system install this package and any dependencies needed to allow you to use it. The first time you run Miro, setup will ask if you want it to start automatically and also do you want it to search for videos. The videos will be placed in the My Library section and then may be viewed any time by selecting them."

Another resource for the REALbasic programmer is a bi-monthly magazine. One may download a sample issue by visiting their web site. Each issue promises to have more than 50 pages covering all aspects and having material for beginners as well as professionals.

In conclusion, this is a really well developed system, which is evolving. The sample issue contained an interview with the creator of REALbasic and his desire was to create an easy to use system which would let anyone develop professional looking GUI applications easily and have fun doing so. From my experience using it so far, he has accomplished his desire.

I was able to try the Linux version and the Windows version so I must tell that the Windows version clearly states that this will only be usable for 30 days. Also, applications developed for the Windows version would only function
for 10 days.

As I mentioned at the beginning, by the time you are reading this issue the very latest version should be at the Real Software website. Also, the direct download has the advantage that the tutorial material is immediately usable.

Resources:

REAL Software Inc.  
http://www.realbasic.com
REALbasic Developer Magazine  
http://www.rbdeveloper.com
RBtv http://www.realbasic.tv
RBLibrary http://rblibrary.com
Xampp and Joomla Content Management System

This article has resulted from having to set up a Website for a local Computer Club.

I started this project without really understanding what a server was and how to use it to set up a Website. I found the experience enlightening and extremely interesting. What I needed to do was to be able to develop the site on my own computer to teach myself how to use Joomla. Eventually the site will be uploaded to a Web Host, but that is not part of these instructions.

These instructions only cover setting up on your own computer for trial and learning experience.

This is done in two stages

First you need to set up the server part of the installation. Whilst there are a number of ways to do this. I think the method shown below is the easiest way and works fine.
Second, you need to set up Joomla. To find out what Joomla is all about, go to the following site or type Joomla into Google. Joomla is without a doubt an excellent Web site Content Management System and of course it's free. 

www.joomla.org

Instructions for installing Xampp on a local Linux computer

This method has been tested with Mepis and PCLinuxOS 2007.
Get the latest stable version, currently xampp-linux-1.6.4.tar.gz
Save to your Home/yourname/Downloads folder (create one if not there already.)

Download Joomla
You can download Joomla from the repositories using Synaptic. Alternatively you can download Joomla to your
Computer from www.joomla.org
This will be a .tar.gz file. (get latest stable package, in my case it was joomla_1.5RC4.tar.gz)
Save to your Home/yourname/Downloads folder.

Install Xampp for Linux

First open a terminal as root (type su > type root password then press Enter)
cd /home/yourname/Downloads (then press Enter)
tar xvfz xampp-linux-1.6.4.tar.gz -C /opt (then press Enter)
This will create a folder /opt/lampp and Xampp will be installed with all the necessary folders and files. (That was easy wasn't it? ) Have a look in your /opt/lampp folder and you will see all the files there. Next, we need to test Xampp.

Test XAMPP

Still as root, do the following command:
/opt/lampp/lampp start
you should see the following:
Starting XAMPP 1.6.4...
LAMPP: Starting Apache...
LAMPP: Starting MySQL...
LAMPP started.

Now go to your browser (I recommend Firefox) and type the following in the url box:
http://localhost (press Enter)
This should bring up Xampp. And you can try the various Demo's to make sure all is working.
To stop Xampp, do the following (still as root):
/opt/lampp/lampp stop

To Remove Xampp

"If you should ever want to remove Xampp, this is how it's done. However, you'll need Xampp for the next steps."
As su
rm -rf /opt/lampp

The next step is to create a folder called joomla15
This should be as follows
/opt/lampp/htdocs/joomla15

I use file manager super user mode to create the folder.
I then right click on the new folder joomla15 and select Properties > Permissions tab > Advanced permissions and make sure that write permissions are enabled.
When you are finished, exit the file manager.

Install Joomla Files

The next step is to install Joomla into the Joomla15 folder.
Back in the terminal as root still, still be in /home/yourname/Downloads
do the following command:
tar xvfz joomla_1.5RC4.tar.gz -C /opt/lampp/htdocs/joomla15

This should install all the Joomla files into the joomla15 folder.
The installation of the Joomla files is now completed.

Final Install of Joomla and Activate

Run Xampp as su again
/opt/lampp/lampp start

You should now have a web server running on your computer. (there is nothing to see at this point except the message that Xampp is started.)
Open your Browser (Firefox I hope)
In the address bar type: http://localhost/joomla15
This will bring up the 7 steps for installation.

**Step 1**
Select language: en-GB (or your language)
NEXT

**Step 2**
This should bring up the Joomla Pre-installation check screen.
Make sure all entries in the top section are green.
It is possible that the configuration.php writeable is On and red. If it is red you can still continue.
It is also possible in the recommended settings that Register Globals is On and red. If so, just continue.
NEXT

**Step 3**
Read the GNU license
NEXT

**Step 4**
Database Configuration
Database Type: mysql
Host Name: localhost
User Name: root
password: blank (don't put anything in this box)
Database Name: mydatabase (or whatever you like to call your database)
Leave Advanced Settings as is.
NEXT

**Step 5**
FTP Configuration
Leave as is.
NEXT

**Step 6**
Main configuration
Site Name: Whatever you want for your site name.
Your Email: A genuine email address is required here.
Admin Password: admin (and repeat to confirm)
Press the Install sample data button to add sample data (recommended if you are new to Joomla).
NEXT

Step 7
Finish
If at step 2 you had the configuration.php writeable shown as red, you will see a box with the configuration listed in it. Click within the box and it will turn blue (to select all).
Do a Ctrl C to copy the info to the clip board.
In the file manager as su, go to /opt/lampp/htdocs/joomla15. Right click in right hand side.
Then select Create New then Text File and name it configuration.php then save the file. (It will be empty.)
Now open this new file with KWrite and and click within the panel.
Press Ctrl V to paste the content from the clip board into the file.
Save the file. You can now close the file manager.
Important step
It is now necessary to delete or rename the Installation Folder in the joomla15 folder.
Navigate to this folder and Right Click on 'Installation' folder and either Delete it or re-name it. (I renamed it oldinstallation.)

All installation is now completed
Now to check it out
Now restart Xampp if not already running.
(Remember as su /opt/lampp/lampp start.

Now start your Browser and type in http://localhost/joomla15
You should now have the Sample Joomla site up and running and you should be on the front page.
To get to the Administration area, go to the Main menu on the left panel and select Administrator.
This will bring you to the Admin Login screen. Enter admin for the User name and admin for the Password and you should then be in the guts of it and can experiment to your heart’s delight.

Note: When developing the Joomla site, I open two tabs on the browser. One I start as above
http://localhost/joomla15 and one I start as http://localhost/joomla15/administrator. This allows me to switch easily between the Front Page and the Administrator Page to check the affects of alterations made as administrator.
When you have made an alteration and switch to the front page do not forget to press Ctrl + R to reload the page
TIP: Better Video Playback

This is going to be a big help for people who have problems playing videos and are getting washed out colors with too much brightness. The dev people might want to look at this too. What I've found is that modifying the driver prederences for the X11 server will ive much better quality with Kaffeine and Mplayer.

For Mplayer, go to Preferences, Video, and choose the X11 (Ximage/Shm) drivers.

For Kaffeine, go to Settings, Xine Engine Settings and choose the OpenGL drivers. I've tested all the available ones and these five the best results.

DrDOS
PCLinuxOS Magazine is a community project entirely run by volunteers - just like you!

Disclaimer

1. All the contents of PCLinuxOS Magazine (http://www.pclosmag.com) are intended for general information and/or use only. Such contents do not constitute advice and should not be relied upon in making (or refraining from making) any decision. Any specific advice or replies to queries in any part of the magazine is/are the personal opinion(s) of such experts/consultants/persons and are not subscribed to by PCLinuxOS Magazine.
2. The information in PCLinuxOS Magazine is provided on an “AS IS” basis, and all warranties expressed or implied, of any kind, regarding any matter pertaining to any information, advice, or replies, are disclaimed and excluded.
3. PCLinuxOS Magazine and its associates shall not be liable, at any time, for damages (including, without limitation, damages for loss of any kind) arising in contract, tort, or otherwise from the use of, or inability to use, the magazine or any of its contents, or from any action taken (or refrained from being taken) as a result of using the magazine or any such contents or for failure of performance, error, omission, interruption, deletion, defect, delay in operation or transmission, computer virus, communications line failure, theft or destruction or unauthorized access to, alteration of, or use of, information contained in the magazine.
4. No representation, warranties, or guarantees whatsoever are made as to the accuracy, adequacy, reliability, completeness, suitability, or applicability of the information to a particular situation.
5. Certain links on the magazine lead to resources located on other servers maintained by third parties over whom PCLinuxOS Magazine has no control or connection, business or otherwise. These sites are external to PCLinuxOS Magazine and by visiting these, you are doing so of your own accord and assume all responsibility for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by users. PCLinuxOS Magazine accepts no responsibility for the content, accuracy, and conformity to applicable laws of such materials.

Entire Agreement
These items constitute the entire agreement between the parties with respect to the subject matter hereof, and supersedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding such subject matter.